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SOLIDWORKS® 2020 Tutorial Overview of SOLIDWORKS® and the User Interface

Chapter 1
Overview of SOLIDWORKS® 2020 and the User Interface
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Below are the desired outcomes and usage competencies based on the completion of
Chapter 1.

Desired Outcomes: Usage Competencies:

e A comprehensive e Ability to establish a SOLIDWORKS session.
understanding of the
SOLIDWORKS® 2020 User | ® Aptitude to utilize the following items: Menu
Interface (UI) and bar toolbar, Menu bar menu, Drop-down
CommandManager. menus, Context toolbars, Consolidated drop-

down toolbars, System feedback icons,

Confirmation Corner, Heads-up View toolbar,

Document Properties and more.

e Open a new and existing SOLIDWORKS part.

e Knowledge to zoom, rotate and maneuver a
three-button mouse in the SOLIDWORKS
Graphics window.
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Notes:

PAGE 1-2



SOLIDWORKS® 2020 Tutorial Overview of SOLIDWORKS® and the User Interface

Chapter 1 - Overview of SOLIDWORKS® 2020 and the User Interface

Chapter Objective

Provide a comprehensive understanding of the SOLIDWORKS® default User Interface
and CommandManager: Menu bar toolbar, Menu bar menu, Drop-down menu, Right-
click Pop-up menus, Context toolbars/menus, Fly-out tool button, System feedback icons,
Confirmation Corner, Heads-up View toolbar and more.

On the completion of this chapter, you will be able to:

e Utilize the SOLIDWORKS Welcome dialog box.

e Establish a SOLIDWORKS session.

e Comprehend the SOLIDWORKS 2020 User Interface.

e Recognize the default Reference Planes in the FeatureManager.
e Open a new and existing SOLIDWORKS part.

e Utilize SOLIDWORKS Help and SOLIDWORKS Tutorials.

e Zoom, rotate and maneuver a three-button mouse in the SOLIDWORKS Graphics
window.

What is SOLIDWORKS®?

e SOLIDWORKS® is a mechanical design automation software package used to build
parts, assemblies and drawings that takes advantage of the familiar Microsoft®™
Windows graphical user interface.

e SOLIDWORKS is an easy to learn design and analysis tool (SOLIDWORKS
Simulation, SOLIDWORKS Motion, SOLIDWORKS Flow Simulation,
Sustainability, etc.), which makes it possible for designers to quickly sketch 2D and
3D concepts, create 3D parts and assemblies and detail 2D drawings.

e Model dimensions in SOLIDWORKS are associative between parts, assemblies and
drawings. Reference dimensions are one-way associative from the part to the drawing
or from the part to the assembly.

e This book is written for the beginner to intermediate user.
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Start a SOLIDWORKS 2020 Session

Start a SOLIDWORKS 2020 session and familiarize yourself with the SOLIDWORKS User
Interface. As you read and perform the tasks in this chapter, you will obtain a sense of how to
use the book and the structure. Actual input commands or required actions in the chapter are
displayed in bold.

The book does not cover starting a SOLIDWORKS session in detail for the first time. A
default SOLIDWORKS installation presents you with several options. For additional
information, visit http:/ www.SOLIDWORKS.com.

Activity: Start a SOLIDWORKS 2020 Session.

Start a SOLIDWORKS 2020 session.
1) Type SOLIDWORKS 2020 in the Search window.

2) Click the SOLIDWORKS 2020 application (or if available, £ SOLIDWORKS 2020|
double-click the SOLIDWORKS icon on the desktop). The

All Apps Documents Email Web
SOLIDWORKS Welcome dialog box is displayed ” '
by default. Best match
The Welcome dialog box provides a wv 1@ souowgzxs 2020 5
convenient way to open recent documents - P

(Parts, Assemblies and Drawings), view
recent folders, access SOLIDWORKS

Home Recent Learn Alerts og In
resources, and stay updated on
SOLIDWORKS news. et

@ part @ Assembly Drawing Advanced... R open

3) View your options. Do not open a
document at this time. Recent Documents view il

Bushing SLDDRW Fly Wheel SLDDRW FLY WHEELSLDDRW. Fly Wheel SLDASM Bracket SLDPRT

4) If the Welcome dialog box is not Y r e "
. . N N
displayed, click the Welcome to A i L 1
ﬁ' ®E L g &
SOLIDWORKS icon from the
Standard toolbar or click Help > < -
Welcome to SOLIDWORKS from the | Recentfotter s eSS
Main menu @ whas e B setatone
’ ?'\ﬁtmdp‘amnMop\qm MysSolidWorks Beta Hot Issues

i) Drawing - % Beta Forum @ Report a Beta Issue
D:\2020 SOLIDWORKS Quick Start\SOLIDWORKS 2020 Instr, N

@ Arrow keys rotate the model. Ctrl + Arrow Keys pan the model, Alt + Arrow Keys rotate the model clockwise and counterclockwise. <>

[ o not show on startup

e L D2 -

wrécome to SOLIDWORKS Ctrl+F2

d

SOLIDWORKS CAM
@ Help

Tutorials
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Home Tab

The Home tab lets you open new and existing
documents, view recent documents and
folders, and access SOLIDWORKS
resources (Part, Assembly, Drawing,
Advanced mode, Open).

Recent Tab

The Recent tab lets you view a longer list of
recent documents and folders. Sections in the
Recent tab include Documents and Folders.

The Documents section includes thumbnails
of documents that you have opened recently.

Click a thumbnail to open the document, or
hover over a thumbnail to see the document
location and access additional information
about the document. When you hover over a
thumbnail, the full path and last saved date
of the document appears.

Learn Tab

The Learn tab lets you access instructional
resources to help you learn more about the
SOLIDWORKS software.

Sections in the Learn tab include:

¢ Introducing SOLIDWORKS. Open
the Introducing SOLIDWORKS book.

e Tutorials. Open the step-by-step
tutorials in the SOLIDWORKS
software.

e  MySolidWorks Training. Open the
Training section at MySolidWorks.com.

¢ Introducing SOLIDWORKS
(Samples). Open local folders
containing sample models.

e Tutorials (Samples). Open the
SOLIDWORKS Tutorials (videos)
section at solidworks.com.

Overview of SOLIDWORKS® and the User Interface

Home Recent Learn Alerts
RS
New

@ Assembly Drawing

FRONT-SUPPORTSL. AirCylinder SLDASM Hole Wizard 220SL.

Recent Folders View all

i) Chopter4 - Homework
DA2020 SOLIDWORKS ENGINEERING DESIGN\ENGOESIGN.

i Chopter2- Homework
2020 SOLIDWORKS ENGINEERING DESIGN\ENGDESIGN.

T3 012020 souworss encimesai sismencosson

Advanced...

Resources
@ What's New
MySolidWorks

¥ Beta Forum

|

[ open

View all

Fill Pattern 222 SLDP.

G

Fill Pattern 221.SLDP.
.
NN
&

i |
QL a
Lg

B Beta Home
Beta Hot Issues

(@ Report a Beta Issue

Bushing. SLDDRW
e
)

Fly Wheel SLDDRW. FLY WHEELSLDDRW

&7 =FE

Bushing SLOPRT AxleSLDPRT Wheel SLOPRT

&
&
&

Draw1.SLDDRW AutoBalloon 13-1SL.

Fly Wheel SLDDRW.

@ Arrow keys Ctrl + Arrow Keys Alt + Arrow Keys rotate the model clocky < )
0] Do not show on startup

3
Documents  Folders Browse...
Quickfiter: | @ |B| T | Filter by name Remove v

Fly Wheel SLDASM BracketSLDPRT

g@

2MM Set ScrewSLDP.

o
®
Collar.SLDPRT

® o

Projected View 13-1... tiring Engine Modif.

d @

Home  Recent Lrarn Alerts
e

Introducing SOLIDWORKS Tutorials

+ SOLIDWORKS Fundamentals.

« Parts, Assemblies and Drawings

« Engineering Tasks

..and more

Samples
Introducing SOLI... Tutorials What's New
Samples Samples Samples MySolidWorks
& ‘ & a; A Q CAD Models
@ Online Tutorials & My Training R Certfication # Curriculum

[ 0o not show on startup.

MySolidWorks Training

+ Unlimited 24
 Follow along using example files

- Test your knowledge

e What’s New (Samples). List of new changes.
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e MySOLIDWORKS - CAD Models. Open models in 3D ContentCentral and the

Community Library.

e My Training. Open the My Training section at MySolidWorks.com.

e Certification. Open the SOLIDWORKS Certification Program section at

solidworks.com.

e Curriculum. Open the Curriculum section at solidworks.com.

w1

¥* When you install the software, if you do not install the Help Files or Example Files, the

Tutorials and Samples links are unavailable.

Alerts Tab

The Alerts tab keeps you updated
with SOLIDWORKS news.

Sections in the Alerts tab include
Critical, Troubleshooting, and
Technical.

w1

“¥* The Critical section does not
appear if there are no critical alerts
to display.

e Troubleshooting. Includes
troubleshooting messages and
recovered documents that used
to be on the SOLIDWORKS
Recovery tab in the Task Pane.

Home Recent Learn A|Erts

Troubleshooting Technical Alerts

SOLIDWORKS 2020 B2.1 online is now available for testing!
Mon, 29 Jul 2019 00:00:00 EST

WANTED: Splash Screen Contest Entries!
Sun, 21 Jul 2019 13:20:44 EST

Your Free Licenses in Beta2 are...
Mon, 15 Jul 2019 00:00:00 EST

SOLIDWORKS 2020 Beta online is here!
Mon, 01 Jul 2019 00:00:00 EST

Free product licenses, contest information, known issues and more on the Beta Forum...
Mon, 24 Jun 2019 00:00:00 EST

SOLIDWORKS 2020 Beta is Live!
Mon, 17 Jun 2019 00:00:00 EST

Your Free Licenses in Beta1 are...
Mon, 17 Jun 2019 00:00:00 EST v

[ Do not show on startup

Lt Recent Folders

“¥* If the software has a technical [ simulation
problem and an associated troubleshooting message exists, the CAUsers\PubliciDocuments\SOLID
Welcome dialog box opens to the Troubleshooting section [ Manuals

automatically on startup, even if you selected Do not show at

startup in the dialog box.

e Technical Alerts. Open the contents of the SOLIDWORKS

C:\Program Files\SOLIDWORKS Co|

Final models
i .

@ Arrow keys rotate the model. Ctrl + Arr|

Support Bulletins RSS feed at solidworks.com. '—_[?” not show on startup

Close the Welcome dialog box.

5) Click Close * from the Welcome dialog box. The SOLIDWORKS P
Graphics window is displayed. Note: You can also click outside the ’
Welcome dialog box, in the Graphics window.

Close
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View the SOLIDWORKS Graphics window.

o N o
Zs souwors| File View Tools Help # [ 42} [ -[R%+-| - -0+ s - {'é}- (& T search knowledgeBase Q
|

# Welcome to SOLIDWORKS

SOLIDWORKS Tools
@ Property Tab Builder
@ SOLIDWORKS Rx

@ Performance Benchmark Test

NS

@Compare My Score

i Copy Settings Wizard

®

@My Products

o]
111

Online Resources
@ 3DEXPERIENCE Marketplace

7 o
S SOLIDWORKS

@ Subscription Services

a

If you do not see this screen, click the SOLIDWORKS

Resources o icon on the right side of the Graphics window  Welcome to SOLIDWORKS
located in the Task Pane.

SOLIDWORKS Tools ~

@ Property Tab Builder

6) Hover the mouse pointer over the SOLIDWORKS icon.

@ SOLIDWORKS Rx

@ Performance Benchmark Test

7) Pin * the Menu Bar toolbar.

@ Compare My Score

8) View your options from the Menu bar menu: File, View,
Tools and Help.

4 Copy Settings Wizard
# My Products

Online Resources ~
@ 3DEXPERIENCE Marketplace

3 M H@@E{

sz Partner Solution

DZYSOTDWORKS < File View Tools Help =
RN
177SSOLIDWORKS File View Tools Help t‘tﬁ < 2‘7' - - - - n{é}v
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Menu Bar toolbar

»

AD-FE-8-9N0ES

2
DS SOLIDWORKS

The SOLIDWORKS (UI) is designed
to make maximum use of the Graphics window. The

Menu Bar toolbar contains a set of the most frequently | ® search knowledge ase = Q- 2 ~ _ ] X

used tool buttons from the Standard toolbar.

The following default tools are available:

e  Welcome to SOLIDWORKS O Open the Welcome dialog box, New 1) - Create a
new document; Open B . Open an existing document; Save & - Save an active
document; Print = Print an active document; Undo ¥ _Reverse the last action;

Select v Select Sketch entities, components and more; Rebuild @ - Rebuild the active
part, assembly or drawing; File Properties &= - Show the summary information on the

active document; and Options {5 Change system options and Add-Ins for
SOLIDWORKS.

Menu Bar menu

Click SOLIDWORKS in the Menu Bar toolbar to ,77_"; SOLIDWORKS |\ Fle View Tools Help 8
display the Menu Bar menu. SOLIDWORKS -
provides a context-sensitive menu
structure. The menu titles remain the | 7S SOL.'DWORKSE&‘ Fle Edit View Insert Tools Window Help

same for all three types of
documents, but the menu items change depending on which type of document is active.

Example: The Insert menu includes features in part documents, mates in assembly
documents, and drawing views in drawing documents. The display of the menu is also
dependent on the workflow customization that you have selected. The default menu items for
an active document are File, Edit, View, Insert, Tools, Window, Help and Pin.

The Pin * option displays the Menu bar toolbar and the Menu bar menu as illustrated.
Throughout the book, the Menu bar menu and the Menu bar toolbar are referred to as the
Menu bar.

D%'SOLIDWORKS % File View Tools Help 44

‘D%.SOLIDWORKS 4 File Edit View Insert Tools Window Help 48

JD%SOLIDWORKS File Edit View Insert Tools Window Help ﬂ @ '|21/" E' ' {é\}"
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Drop-down menu

SOLIDWORKS takes advantage of the familiar Microsoft® Windows
user interface. Communicate with SOLIDWORKS through drop-
down menus, Context sensitive toolbars, Consolidated toolbars or the
CommandManager tabs.

‘¥ A command is an instruction that informs SOLIDWORKS to
perform a task.

To close a SOLIDWORKS drop-down menu, press the Esc key. You
can also click any other part of the SOLIDWORKS Graphics window
or click another drop-down menu.

Create a New Part Document

In the next section create a new part document.

Overview of SOLIDWORKS® and the User Interface

File Edit View Insert Tools Window Help

Ctrl+N
Ctrl+O

New...
¥ Open...

Open Recent
Open Drawing

% Close Ctrl+W

58 Make Drawing from Part
@ Make Assembly from Part

& save

3]

Ctrl+S
Save As...

@ saveal

Page Setup...
@ Print Preview...
& Print..
[ Print3D...

Ctrl+P

4& Publish to eDrawings

™ Pack and Go.
Send To...

Find References...
[ Properties...

Exit

Customize Menu

Activity: Create a new Part Document.

A part is a 3D model which consists of features. What are
features?

Y

S ERle[@KT

Features are geometry building blocks.

‘% TRIANGLE (Default<<Defaults|

Most features either add or remove material.
Some features do not affect material (Cosmetic Thread).

Features are created either from 2D or 3D sketched profiles
or from edges and faces of existing geometry.

Features are individual shapes that combined with other
features make up a part or assembly. Some features, such as
bosses and cuts, originate as sketches. Other features, such as
shells and fillets, modify a feature's geometry.

Features are displayed in the FeatureManager as illustrated

(Boss-Extrudel, Cut-Extrudel, Cut-Extrude2, Mirrorl, \*
Cut-Extrude3 and CirPatternl). \
¥ The first sketch of a part is called the Base Sketch. The \

Base sketch is the foundation for the 3D model. The book LS

focuses on 2D sketches and 3D features.

w1
-~ Y

N

FeatureManager tabs and tree folders will vary
depending on system setup and Add-ins.

-

History
Sensors
Design Binder
Annotations
Solid Bodies(1)
Equations

O —
2% Material <not specified>

m Front Plane

ﬂj Top Plane
m Right Plane

I__ Origin

@ Boss-Extrude
C Sketch1

Cut-Extrude
C Sketch2

Cut-Extrude2
C Sketch3

[hllﬂ Mirror1

Cut-Extrude3

C Sketch4

=,
ka CirPattern1
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There are two modes in the New

New SOLIDWORKS Document X

SOLIDWORKS Document dialog
box: Novice and Advanced. The

Novice option is the default option
with three templates. The i
Advanced mode contains access to £h

additional templates and tabs that
you create in system options. Use
the Advanced mode in this book.

Part Assembly Drawing

a 3D representation of a single design a 3D arrangement of parts and/or other  a 2D engineering drawing, typically of a
component  assem blies part or assembly

Create a new part. Novice mode

9) Click New (3 from the Menu oK Cance Help
bar. The New SOLIDWORKS

Document dialog box is
displayed.

New SOLIDWORKS Document X

~
Select the Advanced mode. Templates MBD  Tutorial
10) Click the Advanced button as mEm = 3=

. Assembly -
illustrated. The Advanced Drawing Preview

mode is set.

11) Click the Templates tab.

12) Click Part. Part is the default
template from the New
SOLIDWORKS Document
dialog box.

13) Click OK from the New
SOLIDWORKS Document T = — s
dialog box.

Advanced mode

w1

A [Mlustrations may vary depending on your SOLIDWORKS version and operating system.

The Advanced mode remains selected for all new documents in the current SOLIDWORKS
session. When you exit SOLIDWORKS, the Advanced mode setting is saved.

The default SOLIDWORKS installation contains three tabs in the New SOLIDWORKS
Document dialog box: Templates, MBD, and Tutorial. The Templates tab corresponds to the
default SOLIDWORKS templates. The MBD tab corresponds to the templates utilized in the
SOLIDWORKS (Model Based Definition). The Tutorial tab corresponds to the templates
utilized in the SOLIDWORKS Tutorials.
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Part1 is displayed in the FeatureManager and is the name of the document. Part1 is the default
part window name.

The Part Origin J“ is displayed in blue in the center of the Graphics window. The Origin
represents the intersection of the three default reference planes: Front Plane, Top Plane and
Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front
view. The positive Y-axis is vertical and points upward in the Front view. The
FeatureManager contains a list of features, reference geometry, and settings utilized in the
part.

w1 MEKS (meter, kilogram, second)
“¥" Edit the document units directly from the Graphics window as o
illustrated. 1PS {inch, pound, second)
I Edit Document Units.. -
sl Editing Part VT ;
e e

CommandManager and FeatureManager tabs will vary
depending on system setup and Add-ins.

Main Menu Toolbar

~
75 soumworks  File Edit View Insert Tools Windom » @ D vB}-- E ® I).

C ¢ /0ON#EHPL @
Sketch ~ Smart - (\@ jah Convert Offset

Dimension Entities On

O @ - | . Surface

Fe;tures S;(e(ch Markup | Evaluate | M Dimensit;ns SOLIDWORKS Add-Ins | SOLIDWORKS CAM | S'OLIDWORKSCM'A 8M oL
PPEPAEE @ OB T
o DR & \ ~

. CommandManager Tabs Heads-up View Toolbar
& Part1 (Default<< Default>_Display

History

[Zsensors Part FeatureManager Task Pane
» [&lAnnotations

5Materia| <not specified>

[} Front Plane

[l Top Plane

[1J Right Plane
I-.Origin \ g\o
Hide/Show rigin

FeatureManager tab

Sf®EIe

Triad
i

& > *Trimetric
I Model 3D Views | Motion Study 1
OLIDWORKS®remium 20 MGS - )

/

Model Mode 3D Views Motion Mode Units Tags
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View the Default Sketch Planes.

14)
15)
16)
17)

Click the Front Plane from the FeatureManager.
Click the Top Plane from the FeatureManager.

Click the Right Plane from the FeatureManager.

SOLIDWORKS® 2020 Tutorial

Click the Origin from the FeatureManager. The Origin is the intersection of the Front, Top, and

Right Planes.

B O |/,ON-# O %
e =R OD Nl o
@-& - = Surface

5 sovoworks File Edit View Insert Tools Window Help i‘ @ D [27 Bf)IE ' {ﬁ}- @ searchknowledgeBaseQ~ & 2 - — 0O X

Features | Sketch | Markup | Evaluate | MBD Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | SOLIDWORKS CAM TBM a o

PLAPRE © oSBT

S BER S
7 @
€ Part1 (Default<<Default>_Display E
r
[@1History Ont P|0( @
[ sensors e =
» [AlAnnotations i
FMater . @ 45 did>
) Front[™ane|
J Top
J Right Plane e
1, origin L_ B
b
ks > *Trimetric
S Model | 3D Views | Motion Study 1 | <
art] EditingPart  MMGS - @

Download all needed model files (SW-TUTORIAL-2020 folder) from the SDC Publication
website (www.SDCpublications.com/downloads/978-1-63057-317-1). Open the Bracket part.
Review the features and sketches in the Bracket FeatureManager. Work directly from a local
hard drive.

Activity: Download the SOLIDWORKS folder. Open the Bracket Part.

Download the SOLIDWORKS folder. Open an existing SOLIDWORKS part.

18)

19)
20)
21)

Download the SW-TUTORIAL-2020 folder.

Click Open i from the Menu bar menu.
Browse to the SW-TUTORIAL-2020\Bracket folder.

Double-click the Bracket part. The Bracket part is
displayed in the Graphics window.

PAGE 1-12
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File Edit View Insert Tools Window Help # ﬁ D .[21/.. Ev‘)vm ' {@}v T searchknowledgeBaseQ~ & 2 - — O X
@ 3 fSwept Boss/Base @ @ ﬁ Swept Cut @ EE @ Rib Wrap .ﬂ U %

Brtruded Revolved  fil | ofted Boss/Base  Brtruded Hole Revolved (T Lofted cut  F1"e* Lo BN prag (N intersect Reference Curves linstai
Boss/Base Boss/Base cut  Wizard  cyt Pattern Geometry

Boundary Boss/Base . @ Boundary Cut . @ Shell '|'{| Mirror

Features ‘ Sketch ‘ Markup ‘ Evaluate ‘ MBD Dimensions =~ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ SOLIDWORKS CAM TBM ‘ g _ 5 X

Jye KE P @ -
&R I6 @R PPLPEPEE 0 o SR
7

2
DS SOLIDWORKS

N]

> [@Solid Bodies(1)
gi Material <not specified>
[ Front Plane

& Bracket (Default< <Defau|t>,Dis\ @
> [@History

[ sensors Part FeatureManager tree E
> [l Annotations
> [ Markups

[ Top Plane
[J Right Plane
L Origin
4 @Extrude—Thim
B Fillett
» [B25.0 (5) Diameter Hole1
EE LPattern1
» [@210.0 (10) Diameter Hole1
EE LPattern2
Cut-Extrude1
EE LPattern3 Y

A

< 2 | *Isometric
- Model \ 3D Views \ Motion Study 1 \

=)

The FeatureManager design tree is located on the left side of the SOLIDWORKS Graphics
window. The FeatureManager provides a summarized view of the active part, assembly, or
drawing document. The tree displays the details on how the part, assembly or drawing
document was created.

Use the FeatureManager rollback bar to temporarily roll back to an earlier state, to absorbed
features, roll forward, roll to previous, or roll to the end of the FeatureManager design tree.
You can add new features or edit existing features while the model is in the rolled-back state.
You can save models with the rollback bar placed anywhere.

In the next section, review the features in the Bracket FeatureManager using the Rollback bar.

Activity: Use the FeatureManager Rollback Bar option.

Apply the FeatureManager Rollback Bar. Revert to an earlier state in the model.

22) Place the mouse pointer over the rollback bar in the FeatureManager design tree as illustrated.

The pointer changes to a hand @l-. Note the provided information on the feature. This is called
Dynamic Reference Visualization.

» @ Extrude-Thin1

B Fillet1

» &) Extrude-Thin1

23) Drag the rollback bar up the FeatureManager B Fillet A
design tree until it is above the features you » [B250 (5) Diameter Hole
want rolled back, in this case 10.0 (10) L LPatternt

H || 1 @Q 0.0 (10) Diameter Hole
Dla “etel olel. 4 Lv}@ 0.0 (10) DiametePdole

» & @50 (5) Diameter Hole1

EE LPattern2

B>
LPattern2 =
ME » Cut-Extrude1
» & Cut-Extrudet B
e LPattern3

EE LPattern3 GF

24) Release the mouse button.
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View the first feature in the Bracket Part.

25) Drag the rollback bar up the FeatureManager above Fillet1. View the results in the Graphics

window.

RLEEPEEB T SR T

]

S ER e C By
v

& Bracket (Default<<Default>_Dis
> [@lHistory
[ sensors
» [&] Annotations
> [IMarkups
» [@1Solid Bodies(1)
$% Material <not specified>
[ Front Plane
i Top Plane }
[Ej Right Plane
1, origin
> @Exﬁrude Thin1

B Fillet1 ;
» st 0 (5) Diameter Hole1
{ LPattern1 \

» 32100 (10) Diameter Hole1
LPattern2

J Cut-Extrudel

§§ LPattern3 Y

< > | *Isometric

s soipworks | File Edit View Insert Tools Window Help x‘ ﬁ .B‘y.ﬁ. gv‘)uz ' {@}v @ searchknowledgeBase Q- & 2?2 - — 0O X
, o B o [ o
fSwe t Boss/Base @ (A ﬁ Swept Cut @ Rib Wra U
& 9 P E 0y P @ BE &g Wrap 7] <§
Extruded Revolved i Lofted Boss/Base | Extruded Hole Revolved m Lofted cut | Fillet Linear EDraft [@ et orerencelCuves
Boss/Base Boss/Base Cut  Wizard  cut Pattern Geometry
Boundary Boss/Base Boundary Cut . @ Shell '|‘{| Mirror .

Features | Sketch ‘ Markup‘ Evaluate‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ SOLIDWORKS CAM TBM h 0O _ & X

! Model | 3D Views Motion Study 1

Return to the original Bracket Part FeatureManager.
26) Right-click Extrude-Thin1 in the FeatureManager. The Pop-up Context toolbar is displayed.
27) Click Roll to End. View the results in the Graphics window.

?%@@1“«.

4 Solid E Roll to Previous

(\% -
» Desigrtmmg%:

» [A Annot Feature (Extrude-Thin1)

Equati ‘ Roll tqvgnd
Ei Mater Comment
m BT Parent/Child...

m Top Pl
[ Right

N
Origin
» @&l Extrud

Delete...
Add to Favorites

Save Selection

| & @ X%

Configure Feature

g
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Heads-up View toolbar

SOLIDWORKS provides the user with CRORE O @ % -I-

numerous view options. One of the most
useful tools is the Heads-up View toolbar
displayed in the Graphics window when a document is active.

w1

AR Dynamic Annotation Views & : Only available with SOLIDWORKS MBD (Model Based
Definition). Provides the ability to control how annotations are displayed when you rotate
models.

In the next section, apply the following tools: Zoom to Fit, Zoom to Area, Zoom out, Rotate
and select various view orientations from the Heads-up View toolbar.

Activity: Utilize the Heads-up View toolbar.

Zoom to Fit the model in the Graphics window.

i
28) Click the Zoom to Fit icon. The tool fits the model to the
Graphics window.

N\

Zoom to Area on the model in the Graphics window.

29) Click the Zoom to Area p‘ icon. The Zoom to Area Q icon
is displayed.

Zoom in on the top left hole.

30) Window-select the top left corner as illustrated. View the
results.

De-select the Zoom to Area tool.
31) Click the Zoom to Area yo! icon.

Fit the model to the Graphics window.

32) Press the fkey.

5 souowoncs File Edit View Insert Toos Window Help # | ADPFE SN0 B T sunromieneQ- 8 2- - 0O X

Rotate the model. @ O Psensoanne B @ Bore © RO @ @
. el fevched) ) tofed Boss/pase Exuded Mot Revoved ([f] oted cor - FIEt Lve I orae (00 mersect e
33) Hold the middle mouse e ﬁ:v‘:a:;w K @::n‘dw‘m : 'u?f“" L2 -
button down. Drag upward o ERG@F PLEPERB O o SR T .
b, downward b, to the left QD T v 5
. @S rys E
U and to the right U to » Movss g
rotate the model in the LR ‘f‘e
Graphics window. Srien =
gt =

» @JExtrude-Thin1
BFillett

» [325.0 (5) Diameter Hole1
35 LPatternt

» [2210.0 (10) Diameter Holet

3¢ LPattern2
N
<

» B cut-Exdrudet
>
T Model | 3D Views | Motion Study 1

%% LPattern3
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Display a few Standard Views. = =
P FranaBe v el =
34) Click inside the Graphics window. YD

35) Click Front 1 from the drop-down Heads-up view -

toolbar. The model is displayed in the Front view. ’é’g =

36) Click Right ¥ from the drop-down Heads-up view mi=Inn]==
toolbar. The model is displayed in the Right view.

37) Click Top =~ from the drop-down Heads-up view

toolbar. The model is displayed in the Top view. PLAEAPE

Display a Trimetric view of the Bracket model.

. . . ﬁ g g sometric

38) Click Trimetric ¥ from the drop-down Heads-up = Bimetric

view toolbar as illustrated. Note your options. View the - @ Timenic
results in the Graphics window. ml=lun]=:| T

SOLIDWORKS Help

Help in SOLIDWORKS is context-sensitive and in
HTML format. Help is accessed in many ways,

including Help buttons in all dialog boxes and PropertyManager (or press F1) and Help @
tool on the Standard toolbar for SOLIDWORKS Help.

Bs CommandManager and FeatureManagers tabs will vary depending on system setup and
SOLIDWORKS Add-ins.

File Edit View Insert Tools Window:{\[p f‘ ﬁ@.g.l’ %. {é} Q-8 2-_ o X
@ 3 fSweptBoss/Base @ ﬁSweptCut @ EE @Rib Wrap .ﬂ U %

Extruded Revolved i Lofted Boss/Base EXt"“dEd sl Revolved @ Lofted cut | Tillet Linear E Draft @ Intersect Reference Curves InSia
Boss/Base Boss/Base Cut  Wizard  cyt Pattern Geometry

Boundary Boss/Base . Boundary Cut . @ Shell ’|EC| Mirror

2
J DS SOLIDWORKS

Features ‘Sketch‘ Markup | Evaluate | MBD Dimensions SOLIDWORKS Add-Ins | SOLIDWORKSCAM | SOLDWORKSCAMTBM | = 5 _ =

PLGOEB T » S22
;%Q&

@ Bracket (Default<<Default>_»
e History
Sensors
» [&] Annotations
e Markups
[@]Solid Bodies(1)
giMateriaI <not specified> ]

AN

ﬂ Front Plane
ﬂ Top Plane
ﬂ Right Plane
1. Origin
@) Extrude-Thin1
B Fillet1
3 25.0 (5) Diameter Hole1
EL Lpatternt
32100 (10) Diameter Hole Y
EL Lpattern2
’ Cut-Extrude1 z‘Jk X

B | pattarn3 v

A ®

*Isometric

- Model | 3D Views Motion Study 1
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39) Click Help from the Menu bar.

40) Click Help ® from the drop-down menu. The

e D ®E B
10

elcome to SOLIDWORKS

SOLIDWORKS Home Page is displayed by default. .,
View your options. @ Help
[y ._\souowom(s CAM
AR SOLIDWORKS Web Help is active by default I s
under Help in the Main menu. API Help
Use Web Help
Search

Close Help. Return to the SOLIDWORKS Graphics window.
Release Notes

41) Close (X SOLIDWORKS Home. What's New
& Introducing SOLIDWORKS (pdf)
Moving from 2D to 3D

SOLIDWORKS Tutorials
Display and explore the SOLIDWORKS tutorials.
42) Click Help from the Menu bar.

43) Click Tutorials. The SOLIDWORKS Tutorials are =2 SOLIDWORKS Tutorials _ O J
displayed. The SOLIDWORKS Tutorials are
presented by category.

44) Click the Getting Started category. The Getting
Started category provides lessons on parts,
assemblies, and drawings.

< & &
Show Back Print

SOLIDWORKS Tutorials: Getting Started
Getting Sﬁrted Basic Techniques

Advanced Tethniques Productivity Tools

Design Evaluation CSWP/CSWA Preparation

In the next section, close all models, tutorials and
view the additional User Interface tools.

Activity: Close all Tutorials and Models.

Close SOLIDWORKS Tutorials and models.
45) Close Ed SOLIDWORKS Tutorials.
46) Click Window, Close All from the Menu bar menu.

Winch Help )'f‘ Q'B}'
Ing

y Viewport

N New Window
User Interface Tools =

9 Cascade
The book utilizes additional areas of the U Tile Horizontally

=

SOLIDWORKS User Interface. Explore an overview

. . Tile Verticall
of these tools in the next section. D] e e

Arrange lcons

S Close All

1 Part1 *

2 Bracket.SLDPRT

Browse Open Documents...

Customize Menu
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nght-CIICk C; - @@
Right-click in the Graphics window ona  |£  Zoom to Fit
model, or in the FeatureManager on a «IQ Zoom to Area
feature or sketch to display the Context- #) Zoom In/Out
.. . . € Rotate View
sensitive toolbar. If you are in the middle & pan
of a command, this toolbar displays alist ~ |@ rojiview
of options specifically related to that Rotate About Scene Floor
command. Set Current View As...
i . . & View Orientation...
Right-click an empty space in the £ Edit Scene
Graphics window of a part or assembly, &  Show Hidden Components
and a selection context toolbar above the ~ [E¥  Open Drawing
shortcut menu is displayed. This provides | Move (T
easy access to the most commonly used Y TempEEy e
. Recent Commands
selection tools.
Contour Select Tool
Customize Menu

SR« @
FC2PLBP

Consolidated toolbar

Similar commands are grouped together in the CommandManager.
For example, variations of the Rectangle sketch tool are grouped in
a single fly-out button as illustrated.

If you select the Consolidated toolbar button without expanding:

For some commands such as Sketch, the most commonly used
command is performed. This command is the first listed and the
command shown on the button.

For commands such as rectangle, where you may want to
repeatedly create the same variant of the rectangle, the last used
command is performed. This is the highlighted command when the
Consolidated toolbar is expanded.

System feedback icon

Select Tangency
% Save Selection
Zoom/Pan/Rotate
Recent Commands
Face
o0 Change Transparency
G Create Plane Parallel to Screen
Feature (Extrude-Thin1)
Comment
Parent/Child...
3 Configure Feature
x Delete...
Add to Favorites
% Save Selection
Body
Isolate
Export to DXF / DWG

FeatureWorks...

YAMOMIAS™
O -O-A

. g)rner Rectangle

[=] Center Rectangle

i Q 3 Point Corner Rectangle
Q) 3 Point Center Rectangle
) Parallelogram

SOLIDWORKS provides system feedback by attaching a
symbol to the mouse pointer cursor. [}

The system feedback symbol indicates what you are

by | [Re

k. ]

Face - Edge'Dimension- - Vertexq|

selecting or what the system is expecting you to select.

As you move the mouse pointer across
your model, system feedback is
displayed in the form of a symbol,
riding next to the cursor as illustrated.
This is a valuable feature in
SOLIDWORKS.
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Confirmation Corner

When numerous SOLIDWORKS commands are active, a symbol or a set
of symbols is displayed in the upper right-hand corner of the Graphics
window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two
symbols. The first symbol is the sketch tool icon. The second symbol is a
large red X. These two symbols supply a visual reminder that you are in
an active sketch. Click the sketch symbol icon to exit the sketch and to
save any changes that you made.

When other commands are active, the confirmation corner box provides a
green check mark and a large red X. Use the green check mark to execute
the current command. Use the large red X to cancel the command.

w1

Confirm changes you make in sketches and tools by using the D

keyboard shortcut to move the OK and Cancel buttons to the pointer location in

the Graphics window.

Heads-up View toolbar
SOLIDWORKS provides the user

with numerous view options from

. : Standard Vi
the Standard Views, View and ancare Views

Heads-up View toolbar. Byl Y= @ &

The Heads-up View toolbar is a View

transparent toolbar that is displayed o PE -9 o -2l -

in the Graphics window when a

document is active. 2 &j & g & H-§-®- @ @ -3 -

You can hide, move or modify the

Heads-up View toolbar. To modify LPHROZCER | -®-Q@
A S

the Heads-up View toolbar, right-
click on a tool and select or deselect

o~

the tools that you want to display. For a drawing document

The following views are available.
Note: available views are document dependent.

e Zoom to Fit ¢~ : Fit the model to the Graphics window.

e Zoom to Area 00 : Zoom to the areas you select with a bounding box.

2 . : :
e  Previous View 9 : Display the previous view.
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o Section View @: Display a cutaway of a
part or assembly, using one or more
cross section planes.

e  Dynamic Annotation Views @: Only
available with SOLIDWORKS MBD.
Control how annotations are displayed
when you rotate a model.

PEEPR

View Selector (Ctrl+SpaceBar)

Show or hide the in-context View Selector to choose
from a variety of standard and non-standard view T
orientations. Press Alt to expose only the back faces of @»

the View Selector.

Buveeas

VR

The Orientation dialog has an option to
display a view cube (in-context View
Selector) with a live model preview. This
helps the user to understand how each
standard view orientates the model. With the

view cube, you can access additional standard views. The
views are easy to understand and they can be accessed

simply by selecting a face on the cube.

To activate the Orientation dialog box, press (Ctrl +
spacebar) or click the View Orientation © icon from

the Heads up View toolbar. The active model is displayed
in the View Selector in an Isometric orientation (default

view).

Click the View Selector icon in the Orientation dialog
box to show or hide the in-context View Selector.

w1

Selector.

w1

dialog box.

e View Orientation box @& " Select a view

orientation or the number of viewports. The

options are Top, Left, Front, Right, Back,

Bottom, Single view, Two view - Horizontal,
Two view - Vertical, Four view. Click the drop- -

down arrow to access Axonometric views:
Isometric, Dimetric and Trimetric.

e Display Style @ “: Display the style for the
active view. The options are Wireframe, Hidden
Lines Visible, Hidden Lines Removed, Shaded,

Shaded With Edges.

“¥" Press Ctrl + spacebar to activate the View

“¥" Press the spacebar to activate the Orientation

POZPAB T » SR 3

R ye
pat &

L
g 4
ml=unlz

YR T Rk

Erers]- (G
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e Hide/Show Items ® “: Select items to hide or show in the Graphics
window. The available items are document dependent. Note the View

Center of Mass ¥ icon.

e [Edit Appearance @ : Edit the appearance of entities of the model.

o Apply Scene 2R : Apply a scene to an active part or assembly

document. View the available options.

o View Settingl-x_-l ": Select the following settings: RealView Graphics,
Shadows In Shaded Mode, Ambient Occlusion, Perspective and

Cartoon.

e Rotate view ¢ : Rotate a drawing view. Input Drawing view angle

and select the ability to update and rotate
center marks with view.

e 3D Drawing View 6. Dynamically
manipulate the drawing view in 3D to
make a selection.

-

@ RealView Graphics
ﬁ Shadows In Shaded Mode
G Ambient Occlusion

% Perspective @

To display a grid for a part, click Options G- , | @ cartoon &
Document Properties tab. Click Grid/Snaps, — —
check the Display grid box. FPHEIECER - ®-@

w1

“¥* Add a custom view to the Heads-up View ' @]
toolbar. Press the space key. The Orienit;ation dialog “\(’,Ptions
box is displayed. Click the New View & tool. The ggi?g@%‘;pém settings for
Name View dialog box is displayed. Enter a new '
named view. Click OK.

N : \A/‘ T ~
5 1 ] m nable CommandManager QERWORKSICAMITEM
Use commands to dlspla}{ 1.nformat10.n abopt the e ,ég Py
triad or to change the position and orientation of the Tabs 7] Features
triad. Available commands depend on the triad's e B s
COl’lteXt. Surfaces
Sheet Metal

s Structure System

- - Weldments

“¥" Save space in the CommandManager, limit Mold ook

. . es odeling
your CommandManager tabs. Right-click on a Data Migration
CommandManager tab. Click Tabs. View your e g
options to display CommandManager tabs. Evaluate
¥ | MBD Dimensions
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SOLIDWORKS CommandManager

The SOLIDWORKS CommandManager is a Context-sensitive toolbar. By default, it has
toolbars embedded in it based on your active document type. When you click a tab below the
CommandManager, it updates to display that toolbar. For example, if you click the Sketch tab,
the Sketch toolbar is displayed.

w1
A

For commercial users, SOLIDWORKS Model Based Definition (MBD) and
SOLIDWORKS CAM is a separate application. For education users, SOLIDWORKS MBD

and SOLIDWORKS CAM is included in the SOLIDWORKS Education Edition.

Below is an illustrated CommandManager for a Part document. Tabs will vary depending on
system setup and Add-ins.

Jp’Ssoquosz File Edit View Insert Tools Window Help »# @ D ~[E" g < If) . é:c}}v Bl
|

ik I @
% g @ Swept Boss/Base Dé @ W Swept Cut @ EE .@ Rib Wrap ﬁ U h\\'b
Extruded Revolved i Lofted Boss/Base Extruded Hole Revolved m Lofted Cut Fillet Linear E Draft @ Intersect Reference Curves |nstant3D
Boss/Base Boss/Base cut  Wizard  cyt Pattern Geometry

@ Boundary Boss/Base @ Boundary Cut @ Shell F‘Eﬂ Mirror

Features ‘ Sketch‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins | SOLIDWORKS CAM ‘ p @ @ @ . @ - - % & . |:|

Q’ <\ ‘/@[U % @ t E’i'{lMirrorEntities %J© @ Ed &

Exit Smart Ij . 0 . @ . A Trim  Convert Offset [RIE] Linear Sketch Pattern  ~ Display/Delete Repair Rapid |Instant2D| Shaded
Sketch| Dimension enet Entities Entities Entities [BlE) Relations  sketch Sketch Sketch

. } - @ j -3 i i S e E - } i Contours
Features Sketch‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ /@ Q &g @ E fi @ - i/:\ - Q: -

g @ $# @ G check & Devation Analysis [{) Dratt Anlysis S e
i O . . Check
'n;rlf:&?s:e Measiice Pr::zsr;es Pf:sgglnes en=ac Zebra Stripes @ Undercut Analysis Acfi:e
. Curvature @ Parting Line Analysis Dogment
Features  Sketch Evaluate | MBD Dimensions = _SOLIDWORKS Add-Ins | SOLIDWORKS CAM | @) BDAUREL B - - & - -
XXX XXX
¢ B & = &H @
Auto Location Size Basic Pattern Datum Geometric
Dimension Dimension Dimension Location  Feature Tolerance
Scheme Dimension
Features ‘ Sketch ‘ Evaluate ‘ MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM
T

@ @ % & T & T B

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
Marketplace 360 Motion Routing Simulation Toolbox

Features ‘ Sketch ‘ Evaluate MBD Dimensions ‘ SOLIDWORKS Add-Ins ‘ SOLIDWORKS CAM ‘ OOREBRED- W) - - % ﬁ -]

g N

1
0 @ tions
“¥" Set button size from the Toolbars tab of the Customize dialog 4 G ,
. . . Customize...
box. To facilitate element selection on touch interfaces such as Addins

tablets, you can set up the larger Size buttons and text from the
Options menu (Standard toolbar).

Save/Restore Settings...

-~y
\‘Button Size
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it

based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for a Drawing document. Tabs will vary
depending on system setup and Add-ins.

m m Y “« g

LB 8 & 3 8Q M KHEIE

D= O 0 ‘¢ Q L |G
Standard Model Projected Auxiliary Section Removed Detail Broken-out Break Crop Alternate

3View View View View View Section View Section View View Position
View

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format ’i

<\ <& Ahé i A AAA VR ;D Balloon V/_ Surface Finish [E[03]Geometric Tolerance 'G} Center Mark A Revision Symbol @

Smart  Model Spell Format Note Linear (7 Auto Balloon /7<Weld s Blocks [} 5 - Tables
. . ymbol Datum Feature Centerline Revision Cloud
Dimension jtems Checker Painter Note 2 ! {:3
. Parfem n Magnetic Line LI@ Hole Callout Datum Target . % Area Hatch/Fill .
View Layout | Annotation ‘Sketch‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format i A BN O A B P a
. (47! H 1
!
<\ / M @ © N - o % lC Eﬂil{l Mirror Entities |
Smart Trim . Display/Delete
] ¢ E - 0 - @ - - Offset EE Linear Sketch Pattern  ~ ~'°P y/.
Dimension Cocd Entities Entities Relations

@0 1 |. . -

View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format i

@
Abc
v v 2 b b 4% &
Spell Measure Markup Section Compare Check DriveWorksXpress
Checker Properties Performance Documents Active Wizard
Evaluation Document
View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format %
2 @
@ @ @ % & T & T K
3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS TolAnalyst
Marketplace 360 Motion Routing Simulation Toolbox
View Layout ‘ Annotation ‘ Sketch ‘ Evaluate ‘ SOLIDWORKS Add-Ins | Sheet Format ~ o e N =
Edit | Title Automatic
Sheet | Block Border
Format | Fields
View Layout ‘ Annotation ’Sketch‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ Sheet Format
0 | |
-0 - . X SOLIDWORKS AdAd_Inc | ALIMAMARKS CANM | <Ol 1N
“¥" To add a custom tab, right-click on a tab and Enable CommandManager
click Customize CommandManager. You can also U2 e S T U
. : Tabs
select to add a blank tab and populate it with custom
Is fir he C ize dial b Toolbars
tools trom the Customize dia 0g DOX. Customize...
by
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The SOLIDWORKS CommandManager is a Context-sensitive toolbar that automatically
updates based on the toolbar you want to access. By default, it has toolbars embedded in it
based on your active document type. The available tools are feature and document dependent.

Below is an illustrated CommandManager for an Assembly document. Tabs will vary
depending on system setup and Add-ins.

o ® =
SN\ B P & B 9P R SIS @
Edit Insert  Mate Component  Linear Smart Move Show Assembly Reference New | Bill of Exploded fj

Component Components P Component Fasteners Component  Hidden  Features Geometry Motion Materials —View
Pattern Components Study

Update Take Large
Speedpak Snapshot Assembly

Settings

Assembly ‘ Layo::t ‘ Sketch ‘ Markup ‘ Evaluat; ‘ SOLIDWORKS Add-Ins ‘ ) {@ /Q @ ﬁ ﬁ ;g' @ . E . @\ . Q & . |:_| .

g < /ONT 5 B L @ o | ~ AN
Create Smart E(\,O,A Convert off-ct Offset o te g Insert

Mate Move  Show

layout Dimension Entities on S Components Component  Hidden
. - . . . Surface tit - . B Insert Block : Components
Assembly | Layout | Sketch | Markup | Evaluate | SOLIDWORKS Add-ins | PDOLMAEB R.- - S 1. o

<\ /v@v[Uv ;::(1' @ @ Mirror Entities lz @
Sketch ~ Smart E . 0 . @ . A Trim Convert Offset  Offset Linear Sketch Pattern - | DisPlay/Delete Repair Quick  Rapid |Instant2E
Dimension eue! Entities Entities Entities On Relations  Sketch |Snaps| Sketch

} } o @ o | . . Surface Move Entities -
Assembly | Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWORKS Add-Ins ‘ @ Q &2 @w

=B\ 2 &

=
Color Draw Erase| Select Touch Note

Features ‘ Sketch ‘ Markup | Evaluate MBD Dimer|

= @ 0 ) o o
o = B ¥ ¢ &G 8 b B B @ B I N & B &
Design Interference Clearance ~ Hole ~Measure Markup Mass  Section Sensor Assembly Performance Curvature Symmetry Body ~Compare ~ Check i i FloXpress Dri inabili
Study  Detection Verification Alignment Properties Properties Visualization ~Evaluation Check Compare Documents  Active Analysis Wizard  Analysis Wizard Costing

Document Wizard
Assembly[uyout\sketch [ Markup‘ Evaluate ‘ SOLIDWORKS Add-Ins \ POL ZAEL- - M - 00 . & X !

®@ ® @ % & TE 6

3DEXPERIENCE CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDW
Marketplace 360 Motion Routing  Simulation

] =

Beam Bearing
Calculator... Calculator...

Assembly ‘ Layout ‘ Sketch ‘ Markup ‘ Evaluate ‘ SOLIDWQRKS Add-Ins [

q

A The Ink Markup toolbar is renamed to the Markup Markup n
toolbar. The Markup tab is displayed by default in the -
CommandManager on some systems. You can draw -
markups with a mouse on non-touch devices, display
bounding boxes for markups, create markups in

drawings, and use the context toolbar to access markup Markup o
options.

R AN

toolbar for nontouch devices

toolbar for touch devices

The Markup toolbar displays different options depending on

the device. Draw’ £ and Touch 2 are not available for
non-touch devices.
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Float the CommandManager. Drag the Features, Sketch or any
CommandManager tab. Drag the CommandManager anywhere
on or outside the SOLIDWORKS window.

To dock the CommandManager, perform one of the following:

While dragging the CommandManager in the SOLIDWORKS
window, move the pointer over a docking icon -

Dock apove Dackleft Dockright and click the needed

command.

Double-click the floating CommandManager to revert the
CommandManager to the last docking position.

Screen shots in the book were made using SOLIDWORKS
2020 SPO running Windows® 10.

Selection Enhancements

Right-click an empty space in the Graphics window of a part or
assembly; a selection context toolbar above the shortcut menu
provides easy access to the most commonly used selection
tools.

¢ Box Selection . Select entities in parts, assemblies, and
drawings by dragging a selection box with the pointer.

e Lasso Selection <. Select entities by drawing a lasso
around the entities.

e Selection Filters ?}'. List of selection filter commands.
e Select Other . Display the Select Other dialog box.
o Select . Display a list of selection commands.

e Magnified Selection 3. Display the magnifying glass,
which gives you a magnified view of a section of a model.

A Save space in the CommandManager, right-click in the
CommandManager and un-check the Use Large Buttons with

Text box. This eliminates the text associated with the tool.
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Enable CommandManagerw

@ 3DEXPERIENCE Marke...
@ CircuitWorks
° PhotoView 360

@O ScanTo3D
& SOLIDWORKS Motion
:E SOLIDWORKS Routing

g SOLIDWORKS Simulati...

? SOLIDWORKS Toolbox

EI TolAnalyst

hs ‘MBD Dimensions ‘Evaluate ‘Sketch ‘Features

CER3E E

Q

2 Zoom to Fit
Zoom to Area
Zoom In/Out
Rotate View
Pan

Roll View

PR EeRoReoRs)

Rotate About Scene Floor

Set Current View As...
View Orientation...
Edit Scene

Open Drawing

Move Component

CREEDQ

Temporary Fix/Group
Recent Commands

Contour Select Tool

Customize Menu

Show Hidden Components

z‘ Enable CommandManager
ZJ Use Large Buttons with Text

Tabs
Toolbars

Customize...
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FeatureManager Design Tree

The FeatureManager consists of various tabs:

% % Bracket (Default< <Default>_Display State 1>)
o FeatureManager design tree ¥ tab. » @ History

Sensors

[A] Annotations

Solid Bodies(1)

25 Material <not specified>

e PropertyManager tab.

v

-

o  ConfigurationManager fa tab.

e DimXpertManager & tab. [} Front Plane
. (! Top Plane
e DisplayManager Q tab. [ Right Plane
1., origin
DN , ]
o CAM FeatureManager tree N\ tab. gEWUde-Th'm
Fillet1

v

@ @5.0 (5) Diameter HoleT
EE LPattern1

(& @10.0 (10) Diameter Hole1
EE LPattern2

Cut-Extrude1

e CAM Operation tree = 1ab.

-

o CAM Tools tree ﬂ tab.

-

s ol
Click the E:Jﬂ direction arrows to expand or B LPattern3
collapse the FeatureManager design tree.

CommandManager and FeatureManager tabs and ) Top Plane
. . [J Right Plane
folder files will vary depending on system setup £, origin
and Add-ins. » @] Extrude-Thin1
Select the Hide/Show FeatureManager Area tab , 5222?(5) Diameter Hlm

EE LPatternt Hide FeatureManager Tree Area

& 210.0 (10) Diamete:
EE LPattern2
Cut-Extrude1

EE LPattern3

;tgm as illustrated to enlarge the Graphics window
for modeling.

w1

_”Q\_ The Sensors tool

located in the FeatureManager | && B o & H‘% R$ & FT
monitors selected properties in a (& S @
part or assembly and alerts you

) @ FLATBAR (Default<<Default> D v X »
when values deviate from the

—
specified limits. There are five ; H::;)ry L B ”
sensor types: Simulation Data, s annd Add IJ§1sor... 2 Mass Properties v
Mass properties, Dimensions, $EMate  Notifications.. Properties ~
Measurement and Costing Data. [ Fronf  Rename tree item 7 Mass v

(] Top Hide/Show Tree Items.. &
[ Righ Collapse Items

1, origi Customize Menu

Value : 0.0113609512 Ib

|:| Alert v
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Various commands provide the ability to control
what is displayed in the FeatureManager design
tree.

1. Show or Hide FeatureManager items.

N Click Options & from the Menu bar. Click
FeatureManager from the System Options tab.
Customize your FeatureManager from the

Hide/Show tree Items dialog box.
2. Filter the FeatureManager design tree. Enter

information in the filter field. You can filter by o

Type of features, Feature names, Sketches,

Cancel Help

Folders, Mates, User-defined tags and Custom
properties.

w1

“¥" Tags are keywords you can add to a
SOLIDWORKS document to make them easier to filter
and to search. The Tags % icon is located in the bottom
right corner of the Graphics window.

w1

A< Collapse all items in the FeatureManager, right-
click and select Collapse items, or press the Shift + C
keys.

The FeatureManager design tree and the Graphics
window are dynamically linked. Select sketches,
features, drawing views, and construction geometry in
either pane.

Split the FeatureManager design tree and either display
two FeatureManager instances, or combine the
FeatureManager design tree with the
ConfigurationManager or PropertyManager.

Move between the FeatureManager design tree,
PropertyManager, ConfigurationManager,
DimXpertManager, DisplayManager and others by
selecting the tab at the top of the menu.
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Q‘k\ RIST@F
? Sketch X
% Bracket (Default<<Default>_Di|
A @ Extrude-Thin1
E Sketch1
~ (& @5.0 (5) Diameter Holef
C Sketch3
E Sketch2
~ [3 10,0 (10) Diameter Hole1
C Sketch5
C Sketch4

- Cut-Extrude1

C Sketch6

BERl¢/@F

@
¢
&, @ FLATBAR-DesignTable ([
History
Sensors
4 Design Binder
Annotations
Solid Bodies(1)

Equations
835 6061 Alloy

-

-

v

< >

GE] @%\O\@ ;
Cor ConfigilrationManage

~ & @ FLATBAR-DesignTable C
4 Tables

[ o Default [ GIDS-SC-1

[< — 3HOLE [ GIDS-SC-1¢

5HOLE [ GIDS-SC-10

7HOLE [ GIDS-SC-1¢

b
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The ConfigurationManager I3 tab is located to the right of the

PropertyManager = B= tab. Use the ConfigurationManager to
create, select and view multiple configurations of parts and
assemblies.

The icons in the ConfigurationManager denote whether the
configuration was created manually or with a design table.

The DimXpertManager & tab provides the ability to insert
dimensions and tolerances manually or automatically. The

options are: Auto Dimension Scheme @, Auto Pair
Tolerance ™3, Basic, Location Dimension [, Basic Size

Dimension D\ General Profile Tolerance E@ , Show
Tolerance Status %o , Copy Scheme “* , Import Scheme H}

SOLIDWORKS® 2020 Tutorial

e

m’\
£2 Fes

WConfigurationManagerl
~ @3 7@ FLATBAR-DesignTable Con

v [Ef Tables

[< & Default [ GIDS-SC-100(

&‘ 3HOLE [ GIDS-SC-1000
&‘ 5HOLE [ GIDS-SC-1000
&‘ 7HOLE [ GIDS-SC-1000

TolAnalyst Study K and Datum Target =

SERoSNER

w1

& B 1o O B

o v DD

A TolAnalyst is available in SOLIDWORKS
Premium.

Fly-out FeatureManager

» (@ L aTBAR-DesignTa

History

The fly-out FeatureManager design tree
provides the ability to view and select items in
the PropertyManager and the FeatureManager
design tree at the same time.

EE LPattern1
v X

Direction 1

Sensors
b Design Binder
v [A] Annotations

@

A A

-

‘Edged)

Throughout the book, you will select commands

Solid Bodies(1)

‘ Equations

and command options from the drop-down
menu, fly-out FeatureManager, Context toolbar,
or from a SOLIDWORKS toolbar.

w1
“¥" Another method for accessing a command
is to use the accelerator key. Accelerator keys
are special key strokes, which activate the drop-
down menu options. Some commands in the
menu bar and items in the drop-down menus

have an underlined character.

® Spacing and instances
O Up to reference

£ 0500in =
) [jﬁ

Direction 2

»

4

»

<

Features and Faces

@ Cut-Extrude1

@

[eodies
Instances to Skip
Options

Vary sketch

|:| Geometry pattern

Propagate visual
properties

O Full preview
@) Partial preview

55 6061 Alloy
m Front Plane
m Top Plane

m Right Plane
I_. Origin

@ Boss-Extrude

13
] 4 ut-Extrude

LPattern

A
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Task Pane

The Task Pane is displayed when a SOLIDWORKS session starts. You can show,
hide, and reorder tabs in the Task Pane. You can also set a tab as the default so it
appears when you open the Task Pane, pin or unpin to the default location.

The Task Pane contains the following default tabs:
e  SOLIDWORKS Resources @

e Design Library @ .

o File Explorer = .

o View Palette .

e

e Appearances, Scenes and Decals
e Custom Properties .

e SOLIDWORKS Forum "2,

w1
-~ Y

Additional tabs are displayed with Add-Ins.

Use the Back and Forward buttons in the Design Library tab
and the Appearances, Scenes, and Decals tab of the Task Pane
to navigate in folders.

SOLIDWORKS Resources

The basic SOLIDWORKS Resources ) menu displays the
following default selections:

o  Welcome to SOLIDWORKS.

o SOLIDWORKS Tools.

e  Online Resources.

e  Subscription Services.

Other user interfaces are available during the initial software

installation selection: Machine Design, Mold Design,
Consumer Products Design, etc.
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gmes e e

> B;ck lesign Library
Toolbox
v 3D ContentCentral
> €@ Supplier Content
> @ User Library
v [ SOLIDWORKS Content
V= Blocks
V= CircuitWorks
> =7 Routing
V=7 Weldments

EuEs

®

Il

I

o Welcome to SOLIDWORKS

SOLIDWORKS Tools
@ Property Tab Builder

& SOLIDWORKS Rx

@ Performance Benchmark Test
@Compare My Score

& Copy Settings Wizard

@ My Products

Online Resources
@ 3DEXPERIENCE Marketplace

w Partner Solutions

Subscription Services

@ Subscription Services
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Design Library

The Design Library @ contains reusable parts, assemblies,

and other elements including library features.

The Design Library tab contains four default selections. Each

default selection contains additional sub categories.

The default selections are:

o Design Library.
e Toolbox.
o 3D ContentCentral (Internet access required).
e  SOLIDWORKS Content (Internet access
required).
w1

Activate the SOLIDWORKS Toolbox. Click
Tools, Add-Ins.., from the Main menu. Check the
SOLIDWORKS Toolbox Library and
SOLIDWORKS Toolbox Utilities box from the Add-
ins dialog box or click SOLIDWORKS Toolbox
from the SOLIDWORKS Add-Ins tab.

To access the Design Library folders in a non-

network environment, click Add File Location @
and browse to the needed path. Paths may vary
depending on your SOLIDWORKS version and
window setup. In a network environment, contact your
IT department for system details.

File Explorer

File Explorer = duplicates Windows Explorer from
your local computer and displays:

® Recent Documents.

o Samples.

e Open in SOLIDWORKS
e Desktop.
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SR

Design Library

GRS
> [ Design Library
T Toolbox
v 3D ContentCentral
> @ Supplier Content
> @ User Library
L@ SOLIDWORKS Content
T [=Blocks
= CircuitWorks
> Routing
= Weldments

/
ANER)

®

ulli

Add-Ins X

Last Load

Active Add-ins 2
Time

Start Up

~/SOLIDWORKS Premium Add-ins
OS# CircuitWorks
D% FeatureWorks
0@ PhotoView 360
1% ScanTo3D
It SOLIDWORKS Design Checker
L1 SOLIDWORKS Motion
[OT€ SOLIDWORKS Routing
: O SOLIDWORKS Simulation
F SOLIDWORKS Toolbox Library

SOLIDWORKS Toolbox Utilities

Oooaoao
A

<1s
<1s
1%} SOLIDWORKS Utilities
KT TolAnalyst

Ooooogoo

~SOLIDWORKS Add-ins

O
O

Autotrace

SOLIDWORKS CAM 2020

SOLIDWORKS Composer
* SOLIDWORKS Forum 2020

SOLIDWORKS PCB 2020

9]
©

2s

i)
©

<1s

[i9]
©

<1s

[m]

(m)
<

Cancel

DLIDWORKS SOLIDWORKS SOLIDWORKS SQLIDWORKS Te
Motion Routing Simulation oolbox

SOLIDWORKS Add-Ins ‘
b

X [« File Explorer
v @0 Open in SOLIDWORKS
@ AirCylinder
© As3054
AS3054 Body
@ AXLE
© FLATBAR
& FLATBAR-3HOLE
@ LINKAGE
@ Motion Study 1
% NCJ22005Z-MP
NCJ2HeadCover
® NCJ2RodCover
NCJ2Rods
NCJ2Tubes
@ Part1
Part2
Part3
© Part4
pneumatic-cylinder-bracket
RodClevis
€ SHAFT-COLLAR
> M Desktop (laptop-hncqqu67)
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seaI'Ch m Search Knowledge Base QE{
Commands "

The SOLIDWORKS Search box is displayed in the upper right corner |5 Files and Models

of the SOLIDWORKS Graphics window (Menu Bar toolbar). Enter Bl Mysolidworks

the text or key words to search.

Knowledge Base

Community Forum

o
New search modes have been added to SOLIDWORKS Search as B Blogs
. & CAD Models
illustrated.

V]

Training

Youtube

RIRRIRIRIRIR] «

Twitter

View Palette

The View Palette tool located in the Task Pane
provides the ability to insert drawing views of an active
document, or click the Browse button to locate the desired Options
dOCleel’lt ﬁ Import Annotations
. . . . @ []Design Annotations
Chf:k and d;ag the view from the V1eyv Pa}ette into an DimXpert Annotations
active drawing sheet to create a drawing view. L5 Oinclude tems from hidden features
s N [13D View Annotations
“¥" The selected model is LINKAGE in the illustration. BE  Davto-strt prjected view
Drag views onto drawing sheet.
8= =\ i ~
ﬁ *Front *Right
e /’”’
*Top *Back
A i o
*Left *Bottom
N =
*lsometric *Dimetric
™\ Y E
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Appearances, Scenes, and Decals

Appearances, Scenes, and Decals e provide a simplified
way to display models in a photo-realistic setting using a
library of Appearances, Scenes, and Decals.

An appearance defines the visual properties of a model,
including color and texture. Appearances do not affect
physical properties, which are defined by materials.

Scenes provide a visual backdrop behind a model. In
SOLIDWORKS they provide reflections on the model.
PhotoView 360 is an Add-in. Drag and drop a selected
appearance, scene or decal on a feature, surface, part or
assembly.

Custom Properties

The Custom Properties tool provides the ability to
enter custom and configuration specific properties directly
into SOLIDWORKS files.

SOLIDWORKS Forum

Click the SOLIDWORKS Forum = icon to search
directly within the Task Pane. An internet connection is
required. You are required to register and to log in for
postings and discussions.

User Interface for Scaling High Resolution
Screens

The SOLIDWORKS software supports high-resolution,
high-pixel density displays. All aspects of the user interface
respond to the Microsoft Windows® display scaling setting.
In dialog boxes, PropertyManagers, and the FeatureManager
design tree, the SOLIDWORKS software uses your display
scaling setting to display buttons and icons at an
appropriate size. Icons that are associated with text are
scaled to a size appropriate for the text. In addition, for
toolbars, you can display Small, Medium, or Large buttons.
Click the Options drop-down arrow from the Standard
Menu bar, and click Button size to size the icons.
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% « Appearances, Scenes, and Decal$s}
. ** ol
@ L4
> OAppearances(color)
@ > & Scenes
@ > @ Decals
-
Y Custom Properties coj
Apply Reset
A property page for assembly files was
@ not found. Click 'Create now...' to
ﬁ launch the Property Tab Builder.
If you already have a template, place it
B in the folder specified in Tools —
Options - File Locations — Custom
Property Files.
e Press F5 to refresh the page.
’ Create now...
Y K SOLIDWORKS Forum <5 &

il aivEEIES

SOLIDWORKS Forum
Search Q

nnnnnnnnnnnnn filling capacities-find the heights of volume

® FORUMS 12 hours ago

projects

12 hours ago
Non-Technical thread: Favorite (clean) jokes
® FORUMS 12 hours ago
Project with [

jct with surface function.
® FORUMS 12 hours ago
e ha

® FORUMS 1 day ago

0ok
g}ﬁ%ptions

Customize...

Add-Ins...

FLATBAR-DesignTablg

Save/Restore Settings...

Button Size D
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Motion Study tab

Motion Studies are graphical simulations of motion for an assembly. Access the
MotionManager from the Motion Study tab. The Motion Study tab is located in the bottom
left corner of the Graphics window.

BadcMation | By 1> > I 2T ] B AR
Eﬁ}{% T B ‘\S\T\\HH‘\S\T\\HH‘\S\T\\HH‘\S\T\\HI\‘\S\T\\HH \TT\\HH|\T\CMHH‘|TTMHH‘\T\c\\HH‘\TT\\HH‘HTT\HH‘HTTIHH i
@ ¢
ol - Motion St
& Orient .
4 Lights ‘
—Q Linear| .
o Gravit| .
o » (@ inran B
<
- Model | 3D Views Motioﬂ>§tudy1 ‘
Incorporate visual properties such as lighting and camera
perspective. Click the Motion Study tab to view the
MotionManager. Click the Model tab to return to the
FeatureManager design tree.
The MotionManager displays a timeline-based interface and
provides the following selections from the drop-down menu as
illustrated:
o Animation: Apply Animation to animate the motion of an
assembly. Add a motor and insert positions of assembly
components at various times using set key points. Use the
Animation option to create animations for motion that do not
require accounting for mass or gravity. N —_— *‘ O = e
e Basic Motion: Apply Basic Motion for 2 Redraw~ cut+r (] Enable CommandMianager
. . . S Capt )
approximating the effects of motors, springs, e & 201030
.. . . . Displ o || ign
collisions and gravity on assemblies. Basic Moty 1% Annotation
Motion takes mass into account in calculating Lights and Cameras ' % ’;“e:‘b'y
. . . . . . A OCKS
motion. Basic Motion computation 1s relatlvely Hide / Show " [& Configurations
fast, so you can use this for creating Toolbars Q\ : E{ Cuis |
. . . . . Work » L Dimensions/Relations
presentation animations using physics-based o By
simulations. Use the Basic Motion option to & Touch Mode © MED Dimension
. . . Display Statt
create simulations of motion that account for [~ s " oming
mass, collisions or gravity. Customize Men @ Explode Sketch
@ Features
s I/_ Bf Formatting
“¥" If the Motion Study tab is not displayed in the . t:fut o
Graphics window, click View > Toolbars > L = Line Format
MotionManager from the Menu bar. . ) Macro
| {7 Markup
@ Mold Tools
tionManager
"
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3D Views tab

SOLIDWORKS MBD (Model Based Definition) lets
you create models without the need for drawings giving
you an integrated manufacturing solution. MBD helps
companies define, organize, and publish 3D product and
manufacturing information (PMI), including 3D model
data in industry standard file formats.

Create 3D drawing views of your parts and assemblies
that contain the model settings needed for review and
manufacturing. This lets users navigate back to those
settings as they evaluate the design.

SOLIDWORKS® 2020 Tutorial

Capture 3D View

Sort order:

History v

Update Previews

mke

- Model}Views Motion Study 1

Use the tools in the MBD Dimensions

2
DS SOLIDWORKS

N
File Edit View Insert Tools Window Help | {2} [ ) [~ (&

CommandManager to set up your model with

selected configurations, including explodes f? L&}
and abbreviated views, annotations, display areneio

states, zoom level, view orientation and section

Dimension Dimension Dimension Location  Feature

Features ‘ Sketch ‘ Markui

XXX =)
] = 3
Size Basic  pattern Datum Geometric

Tolerance
Dimension

p‘ Evaluate ‘ MBD ngensions SOLIDWORKS Add-Ins = S

views. Capture those settings so that you and

other users can return to them at any time using the 3D view palette.

To access the 3D View palette, click the 3D Views tab at the bottom of the SOLIDWORKS
window or the SOLIDWORKS MBD tab in the CommandManager. The Capture 3D View
button opens the Capture 3D View PropertyManager, where you specify the 3D view name,
and the configuration, display state and annotation view to capture. See SOLIDWORKS help

for additional information.

Dynamic Reference Visualization © \ ‘ 1B ‘ 5 ‘ @ ‘ o

(Parent/Child) N

Dynamic Reference Visualization provides the & ® FLATBAR-DesignTable (D

ability to view the parent/child relationships ST

between items in the FeatureManager design Sensors

tree. When you hover over a feature with ’ Design Binder

references in the FeatureManager design tree, > e

arrows display showing the relationships. If a » fi&] solid Bodies(1)

reference cannot be shown because a feature is e

not expanded, the arrow points to the feature —

that contains the reference and the actual 5 6061 Alloy

reference appears in a text box to the right of [ Front Plane M

the arrow. (1] Top Plane ]
Eij Right Plane

I_,Origin < ~
 @soss e} 0

4 Cut-Extrude1 +—Sketch2 ————

P LPatternt < d
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Use Dynamic reference visualization for a

Vieyglnsert Tools Window Help *} ﬁ' '@7" tg' '@ {é\}'

part, assembly and mates. Ty e
. . Screen Capture ' @ ? EI
To display the Dynamic Reference iy R i
Visualization, click View » User Moty »
Lights and Cameras » DRKS Add-Ins | SOLIDWORKS CAM ‘ SOLIDWORKS

Interface > Dynamic Reference
Visualization Parent/Child) from the

Hide / Show

Toolbars

Main menu bar. Workspace :

. Userlnterfax  [¥] Featureanager Tree avea F9

A e et Vostton (o)
Mouse Movements # e R »
A mouse typically has two buttons: a . EAtEPBMg
primary button (usually the left button) o
and a secondary button (usually the right
button). Most mice also include a scroll ]
wheel between the buttons to help you 9
scroll through documents and to Zoom in, WA T
Zoom out and rotate models in o Lﬁ—_ e
SOLIDWORKS. It is hlghly \'}Q\l‘.:_-_—_-_:'.':_:‘.'.‘:.‘.'—'—l.:\: ';,— — .-‘\.\
recommended that you use a mouse LS \
with at least a Primary, Scroll and — 4
Secondary button. ] _ e

(1) Primary button (2) Scroll wheel (3) Secondary button

Single-click

To click an item, point to the item on the screen, and then press and release the primary button
(usually the left button). Clicking is most often used to select (mark) an item or open a menu.
This is sometimes called single-clicking or left-clicking.

Double-click

To double-click an item, point to the item on the screen, and then click twice quickly. If the
two clicks are spaced too far apart, they might be interpreted as two individual clicks rather
than as one double-click. Double-clicking is most often used to open items on your desktop.
For example, you can start a program or open a folder by double-clicking its icon on the
desktop.

Right-click

To right-click an item, point to the item on the screen, and then press and release the
secondary button (usually the right button). Right-clicking an item usually displays a list of
things you can do with the item. Right-click in the open Graphics window or on a command in
SOLIDWORKS, and additional pop-up context is displayed.

Scroll wheel

Use the scroll wheel to zoom-in or to zoom-out of the Graphics window in SOLIDWORKS.
To zoom-in, roll the wheel backward (toward you). To zoom-out, roll the wheel forward
(away from you).
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Summary

SOLIDWORKS® 2020 Tutorial

The SOLIDWORKS (Ul) is designed to make maximum use of the Graphics window for
your model. Displayed toolbars and commands are kept to a minimum.

The SOLIDWORKS User Interface and CommandManager consist of the following main
options: Menu bar toolbar, Menu bar menu, Drop-down menus, Context toolbars,
Consolidated fly-out menus, System feedback icons, Confirmation Corner and Heads-up

View toolbar.

The Part CommandManager controls the display
of tabs: Features, Sketch, Markup, Evaluate,
MBD Dimensions and various SOLIDWORKS
Add-Ins.

The FeatureManager consists of various tabs:

o FeatureManager design tree ® tab.
e PropertyManager tab.

o ConfigurationManager fa tab.

e DimXpertManager & tab.

e DisplayManager é tab.

o (CAM FeatureManager tree @ tab.
o  (CAM Operation tree g. tab.

o CAM Tools tree ? tab.

(s 3
4

Click the %L direction arrows to expand or
collapse the FeatureManager design tree.

CommandManager and FeatureManager tabs and
file folders will vary depending on system setup
and Add-ins.

N
s sovipworks  File Edit View Insert Tools Window Help *‘ ﬁ = Z)yvi
@ 3 f Swept Boss/Base ﬂé @ ﬁ Swept Cu

Extruded Revolved i Lofted Boss/Base Extruded Hfﬂe Revolved @ Lofted Cd
Boss/Base Boss/Base Cut Wizard ¢yt

Boundary Boss/Base Bounda

Features ‘ Sketch‘ Markup ‘ Evaluate = MBD Dimensions ‘ SOLIDWORKS Add-Ins
I

ERoS
v

% Bracket (Default<<Default>_Display State 1>)
4 History

Sensors

Annotations

Solid Bodies(1)

55 Material <not specified>
EQ Front Plane

[ Top Plane

[J Right Plane

i, Origin

@ Extrude-Thin1

@ Fillet1

& 5.0 (5) Diameter HoleT
E% LPatternt

& @10.0 (10) Diameter Hole1
E% LPattern2

Cut-Extrude1

EE LPattern3

& A,
/

-

-

-

-

-

-

You learned about creating a new SOLIDWORKS part and opening
an existing SOLIDWORKS part along with using the Rollback bar

to view the sketches and features.

w1
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% If you modify a document property from an Overall drafting
standard, a modify message is displayed as illustrated.

Overall drafting standard
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w s
-~ s

Use the Search box, in the upper left corner of the Materials
dialog box, to search through the entire materials library.

Material

Search... %

Templates are part, drawing and assembly documents which

include user-defined parameters. Open a new part, drawing « [E] SOLIDWORKS Materials
or assembly. Select a template for the new document. v [Esteel

In Chapter 2, obtain the working familiarity of the following
SOLIDWORKS sketch and feature tools: Line, Circle,
Centerpoint Straight Slot, Smart Dimension, Extruded
Boss/Base, Extruded Cut and Linear Pattern.

Create three individual parts: AXLE, SHAFT-
COLLAR and FLATBAR. @

Create the assembly, LINKAGE using the
three created parts and the downloaded sub-
assembly - AirCylinder.

“¥" The book provides information on creating
and storing special Part templates, Assembly
templates and Drawing templates in the MY-
TEMPLATES folder. The MY-TEMPLATES
folder is added to the New SOLIDWORKS
Document dialog box. Talk to your IT
department before you set any new locations on
a network system. The procedure in the book is
designed for your personal computer.

AR If you do not create the MY-TEMPLATE
tab or the special part, drawing, or assembly
templates, use the standard SOLIDWORKS
default template and apply all of the needed

document properties and custom properties.
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Notes:
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